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UNIT -5 

SQLDB in VB.Net- 

 

Microsoft SQL Server (SQLDB) 

यह Microsoft द्वारा develop किया गया एि Dababase server software है जो िी RDBMS िो 

support िरता है। यह SQL language िा use िर data accessing provide िरता है। Microsoft 

िी सभी programming language इसे support िर database िे किए use िर सिती हैं। यह 

ADO.Net िा एि महत्वपूर्ण कहस्सा है। ADO.Net data provider इसिे किए अिग से सभी data 

accessing facilities provide िरती है। इसे use िरने िे किए सबसे पहिे SQLClient 

,namespace िो import िरते हैं कजसिे किए imports System.Data.SqlClient statement िा 

use किया जाता है। इसमें कनम्न classes होती हैं। SQLDB िे किए SQLConnection object िा use 

किया जाता है। 

Connection: SQLDB मे SQLConnection class िा use किया जाता है। यह SQL Server से 

डाटा access िरने िे किए प्रयोग किया जाता है। इसिे किए Design mode मे Sqlconnection tool 

item िा use िरते हैं जो िी Toolbox में Data category मे उपिब्ध रहता है। इसे form पर place 

िर इसे use किया सिता है। coding िे द्वारा इसे प्रयोग िरने िे किए सबसे पहिे SQLConnection 

class िा object बनाते है और उसमें Connection String िो define िरते हैं। इसिे बाद 

connection िो open िर use किया जा सिता है। इसमें कनम्न प्रिार िी connection string िा 

use किया जा सिता है। 

Data Source=myServerAddress;Initial Catalog=myDataBase;User 

Id=myUsername;Password=myPassword; 

Server=myServerAddress;Database=myDataBase;User 

ID=myUsername;Password=myPassword;Trusted_Connection=True; 

Imports System.Data.SqlClient 

Public Class Form1 
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Private Sub Button1_Click(ByVal sender As System.Object, ByVal e As 

System.EventArgs) Handles Button1.Click 

 

Dim constring As String = “Data Source=.\SQLEXPRESS;AttachDbFilename=C:\SQL 

Server 2000 Sample Databases\NORTHWND.MDF;Integrated Security=True;Connect 

Timeout=30;User Instance=True” 

Dim con As SqlConnection = New SqlConnection(constring) 

Try 

con.Open() 

MsgBox(“Connected Sucessfully”) 

con.Close() 

Catch ex As Exception 

MsgBox(ex.Message) 

End Try 

End Sub 

End Class 

Command: SQL connection िे किए SQLCommand class िे object िा use किया जाता है। 

इसे use िरने िे किए इसिा object declare िर िेते हैं और उसिी सभी important properties िो 

define िर methods िो call िर िेते हैं। 

Imports System.Data.SqlClient 

Public Class Form1 

 

 

Private Sub Button1_Click(ByVal sender As System.Object, ByVal e As 

System.EventArgs) Handles Button1.Click 

Dim constring As String = “Data Source=.\SQLEXPRESS;AttachDbFilename=C:\SQL 

Server 2000 Sample Databases\NORTHWND.MDF;Integrated Security=True;Connect 

Timeout=30;User Instance=True” 
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Dim con As SqlConnection = New SqlConnection(constring) 

Dim cmd As SqlCommand = New SqlCommand 

cmd.Connection = con 

cmd.CommandText = “Select * from Products” 

Try 

con.Open() 

Dim dr As SqlDataReader = cmd.ExecuteReader 

dr.Read() 

MsgBox(dr.Item(0)) 

con.Close() 

Catch ex As Exception 

MsgBox(ex.Message) 

End Try 

End Sub 

End Class 

DataAdapter and DataSet: इसमें DataAdapter SQLDataadpter और dataset normal 

dataset िा object होता है। 

Dim con_str As String = “Data Source=.\SQLEXPRESS;AttachDbFilename=C:\SQL 

Server 2000 Sample Databases\NORTHWND.MDF;Integrated Security=True;Connect 

Timeout=30;User Instance=True” 

Dim con As New SqlConnection(con_str) 

Dim ada As SqlDataAdapter 

Dim ds As New DataSet 

Try 

con.Open() 

ada = New SqlDataAdapter(“Select * from Products”, con) 

ada.Fill(ds) 

con.Close() 

Dim i As Integer 

For i = 0 To ds.Tables(0).Rows.Count – 1 

MsgBox(ds.Tables(0).Rows(i).Item(1)) 

Next 

Catch ex As Exception 

MsgBox(ex.Message) 

End Try 



Visual Basic/VB.Net 

 PAARAS INSTITUTE OF EDUCATION (KASHYAP SIR) 

 

 

 

 

Database Connection Class and Interface- 
 

Database Connection Class and Interface: हािाांकि हम िई प्रिार िे Data Sources िो ADO.NET िे 

माध्‍यम से Frontend से Connect िर सिते हैं, िेकिन किर भी किकभन्न प्रिार िे Data Sources िुछ िाम हमेंशा 

Common रूप से िरते हैं। 

उदाहरर् िे किए हर Data Source पर Connection िो Open ि Close किया जाता है, हर Data Source िे 

Connection िी किसी Particular समय पर एि कनक ”चत स्थिकत होती है, जो Data Source िी Open, Close जैसी 

Current State िो Represent िरता है। सभी प्रिार िे Data Sources पर Apply होने िािे इन Common 

Behaviors िो ADO.NET द्वारा IDbConnection Interface िो Implement िरिे Enforce किया जाता है। 

ADO.NET Connection Object िो हम एि ऐसा Object मान सिते हैं, जो किसी External Resource िे साि 

प्रकिया िरता है। Connection Object किसी External Resource िे साि क्या िाम िरता है, िेिि यही बात 

महत्वपूर्ण नही ां होती है बस्ि कजस Resource िे साि ये Object िाम िरता है, उस Resource ि Frontend िे बीच 

आने&जाने िािा Data Performance िो प्रभाकित िरते हुए Transfer होता है। 

क्योांकि किसी Backend िे साि Connection थिाकपत िरना किसी भी Frontend िे किए सबसे ज्यादा 

Performance Intensive Task होता है। इसी िजह से ये जरूरी होता है कि Connection Object IDisposable 

Interface िो Implement िरे। 

IDisposable Interface, .NET िा एि Standard Interface है, कजसमें Dispose() नाम िा एि Method होता 

है, कजसे Connection Object में Define िरना होता है। ये Method Connection Object िो Allocate किए गए 

Resources िो Release िरने िा िाम िरता है। 

चूांकि Connection Object में IDbConnection Interface िो Implement किया गया होता है, कजसमें 

IDisposable Interface िो Implement किया गया है, इसकिए भी Connection Object में Dispose() Method 

िो Define िरना जरूरी होता है। .NET Data Provider िो IDbConnection Interface में Declare किए गए 

कनम्न Methods िो Implement िरना होता है: 

BeginTransaction() Method 
Data Consistency बना, रखने िे किए ज्यादातर Modern Databases Transactions िे Concept िो Support 

िरते हैं, कजसिे अन्तगणत या तो िामोां िे समूह िे सभी िाम पूरे होते हैं अििा िोई भी िाम पूरा नही ां होता। यानी 

Transaction एि All or Nothing Fashion में िाम िरने िािा Atomic Operation िो Define िरता है, 

कजसमें Specify किए गए या तो सभी Operations Perform होते हैं या किर िोई भी Operation Perform नही ां होता। 

BeginTransaction() एि Common रूप से Use किया जाने िािा ऐसा Function है, जो किसी Database पर 

किसी Transaction िो Begin िरने िे किए Call किया जाता है। ये Method एि Overloaded Method है और इन 

Overloaded Methods में से एि Method हमें Current Transaction िो IsolationLevel में Specify िरने िी 
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सुकिधा Provide िरता है। ये Transaction, System.Transaction Namespace में Implemented Transaction 

से अिग होता है। 

ChangeDatabase() Method 

जब हमारा Frontend किसी Database Server से Connect िरता है, तो एि ही Server पर एि से ज्यादा 

Running Databases हो सिते हैं। इस स्थिकत में ChangeDatabase() Function हमें समान Server पर स्थित 

किकभन्न Databases पर Change िरने िी सुकिधा देता है। 

ChangeDatabase() िो Call िरना एि कबिुि नया Connection Establish िरने िी तुिना में िािी ज्यादा 

Performing होता है। यहाां ति कि Connection Pooling भी इतना Performing नही ां होता। िेकिन ये सुकिधा िेिि 

SQL Server Databases ति ही सीकमत है, क्योांकि SQL Server एि 2-Step Connection Process िो Follow 

िरता है, जहाां पहिे Step में SQL Server, Database से Connect होता है, जबकि दूसरे Step में Catalog िी 

Request िरता है। इसकिए ChangeDatabase() Function िो Call िरिे हम िेिि Catalog िो ही Change 

िरते हैं, नया Connection Establish नही ां िरते। 

Open() Method 

ये Method किसी Database पर Connection िो Open िरता है और उस Open किए गए Connection िो Use 

िरने िा;ि बनाता है, ताकि Frontend Application Database िे Data िो Access ि Manipulate िर सिे। 

Open किया गया Database Connection तब ति Pooled नही ां होता, जब ति कि उसे Explicitly यानी Manually 

Close या Dispose नही ां िर कदया जाता। इसकिए ये जरूरी होता है कि Connection िो कजतना सम्भि हो उतना देर 

से Open किया जाए और कजतना जल्दी हो सिे, उतना जल्दी Close िर कदया जाए। 

एि Developer िे रूप में हमारे किए समझने िािी बात ये है कि हािाांकि Close() ि Dispose() दोनोां ही Methods 

िा प्रयोग Connection Pooling में मदद िरते हैं, िेकिन Close() Method िा प्रयोग िरिे Close किए गए 

Connection िो किर से Open किया जा सिता है जबकि Dispose() Method िा प्रयोग िरिे Dispose किए गए 

Connection िो किर से Open नही ां किया जा सिता। 

CreateCommand() Method 

Database िे साि जो Interaction किया जाता है िह Interaction, Command Object िे माध्‍यम से पूरा होता है। 

Command Object हमें किकभन्न प्रिार िे Parameters िे साि Command Text Specify िरने िी सुकिधा देता है। 

जहाां Command िो Execute िरने िे किए इसे इस बात िी जानिारी होना जरूरी होता है कि Command िो 

किस Database िे Against Execute िरना है। जब किसी Connection Object िे 

किए CreateCommand() Method Execute होता है, तो एि Command Object Create होता है, जो कि उसी 

Connection िे किए Execute होता है कजसिे किए उसे Create किया गया है। 

IDbConnection Interface िे उपरोक्त Methods िे अिािा कनम्न Properties िो भी Implement िरने िी 

जरूरत पडती है: 

ConnectionString Property 

इस Property में हमें उस Data Source से सम्बांकधत किकभन्न जरूरी Parameters िो Specify िरना होता है, कजनिी 

आि”;िता उस Data Source से Connection थिाकपत िरने िे किए जरूरी होती है। हम जरूरत िे अनुसार किसी 

Particular Data Source िे आधार पर इस Property में अन्य Database Specific Parameters भी Specify िर 

सिते हैं। 

ConnectionTimeout Property 
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चूांकि Connection हमेंशा किसी न किसी Physical File िे साि ही थिाकपत किया जाता है, किर भिे ही िह िोई 

Text File हो अििा Database File हो। इस स्थिकत में िई बार किसी िारर्िश िोई Specific File Open नही ां हो 

पाती। 

इस स्थिकत में इस Property द्वारा हम इस बात िो Specify िरते हैं कि हमारा Connection Object अकधितम कितने 

Seconds िे समय ति Connection Establish िरने िी िोकशश िरने िे बाद Connection Fail होने िी प्रकिया 

िो Follow िरेगा। जबकि इस Property में Specify किया गया मान 0 Limitless Timeout िो Represent िरता 

है। 

Database Property 

इस Property में हमें Current Database या उस Database िा नाम Specify िरना होता है, कजसे Connection 

Open होने िे बाद Use िरना है। 

State Property 

ये Property किसी Connection Object िो उसिी Current State Specify िरने िी सुकिधा देता है। इस 

Property िी सबसे ज्यादा Most Common तरीिे से Use िी जाने िािी 

State ConnectionState.Open ि ConnectionState.Closed है। 

DbConnection Class 

ये एि Abstract Class है, कजसे Compulsory रूप से Inherit िरना जरूरी होता है, क्योांकि हम इस Class िे 

Direct Object Create नही ां िर सिते। हर Specific Data Provider िी Connection Class िो इस Class िो 

Inherit िरना Compulsory होता है। DbConnection Class, IDbConnection िो Implement िरता है। 

इसकिए हमें इसे अिग से Implement िरने िी जरूरत नही ां होती है। 

अत: हम हमारे Development िे समय जो भी Data Source Use िरें , सभी Commonality Concept िो Follow 

िरते हुए समान Methods ि Properties Provide िरते हुए Database Access ि Manipulate िरने िी सुकिधा 

देते हैं। 

चूांकि .NET Data Provider िा Connection Object हमेंशा DbConnection Class िो Inherit िरता है, इसकिए 

इस Class िे सभी Logics पहिे से Implemented होते हैं, कजन्हें हम Directly Use िर सिते हैं। 

उदाहरर् िे किए यकद हम SqlConnection Class िो Use िरते है, तो इस Class में DbConnection िो पहिे से 

ही Derive िरने िी िजह से IDbConnection Interface िे सभी Methods ि Properties िो Implement किया 

जा चुिा है। इसीकिए कबना किसी Extra Coding िे हम SqlConnection.Open(), SqlConnection.Dispose(), 

SqlConnection.Close() आकद Methods िो Directly Use िर सिते हैं। 

Connection Pooling 

जब हम ADO.NET िा प्रयोग िरते हुए ऐसे High Demand Applications Create िरते हैं, कजनिा प्रयोग िरते 

हुए एि ही समय पर बहुत सारे Users Concurrently समान Database िो Access ि Manipulate िर रहे होते हैं, 

तब सभी Users िे किए Database Connection िो तब ति Open रखना जब ति कि हर User उस Database 

िो Use िर रहा है, Database िे Performance पर िािी Negative Impact डािता है, जो कि ठीि नही ां िहा 

जा सिता। 

उदाहरर् िे किए Stock Market में हर Second हजारोां Transactions Perform होती हैं और एि ही समय पर 

हजारोां Users समान Database पर Market िी Live Status िो देखने िे किए Request Perform िरते हैं। ऐसे में 

सभी Users िे किए समान समय पर समान Database पर हजारोां Connections िो Open रखना और तब ति 

Open रखना जब ति कि सभी Users उस समान Live Data िो Access िर रहे हैं, Database िी Performance 
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िो बहुत ही ज्यादा प्रभाकित िरता है। पररर्ामस्वरूप Database िे Crash होने िी सम्भािना िािी ज्यादा हो जाती 

है। 

कपछिे Section में हमने इस किष; में िोडा बहुत Discuss किया िा कि IDbConnection, IDisposable िो 

Implement िरता है। जबकि ये जरूरी होता है कि Connection Class हमेंशा IDisposable Interface 

िे Dispose() Method िो Implement िरे] जो कि सभी प्रिार िे Allocated Resources िो Cleanup िरने िा 

िाम िरता है। 

जब हम ADO.NET िा प्रयोग िरते हुए Stock Market जैसा िोई High Demanding Complex Application 

Create िरते हैं, तब हमें SQL Server या Oracle जैसे बहुत ही Powerful Database Server िी जरूरत होती है, 

जो कि समानान्तर रूप से हजारोां Connections िो समान समय पर Handle िरने में सक्षम होते हैं। 

SqlConnection या OracleConnection जैसे Data Provider Specific Connection Objects द्वारा 

ADO.NET सामान्यत: Network िे माध्‍यम से Database Server से Communication िरता है। जबकि हम जानते 

हैं कि Network िी Speed अभी भी िािी िम होती है। इस स्थिकत में समान समय पर एि ही Database Server 

पर हजारोां Connections िो तब ति िे किए Open रखना जब ति कि User किसी Database Server से 

Interaction िरता है, सम्भि नही ां हो सिता। 

इसकिए इस समस्या िे समाधान िे रूप में अिग-अिग Data Source अिग-अिग तरह िे Database Server 

Architectures Use िरते हैं। कजनमें से िुछ Database Servers पहिे से Ready to Use, Open Physical 

Network Connections Use िरते हैं और जो Connection Currently Use में नही ां होता, उसे किसी Particular 

Database Request िो Perform िरने िे किए Use िर िेते हैं। 

ये Architecture सामान्यत: SQL Server िा SqlConnection Object Use िरता है। इस Architecture िो 

उपयोग में िेने िे िारर् SQL Server Database पर िम Physical Connections द्वारा अकधि Request 

िो DbConnection Object िे माध्‍यम से पूरा किया जाना सम्भि हो पाता है। 

इस Architecture िे अन्तगणत DbConnection Object, Connection Pooling नाम िे एि Mechanism िो 

उपयोग में िेता है और पहिे से Perform किए गए Database Request िे Data िो ही कबना अकधि Resources 

िा उपयोग किए हुए अन्य Database Requests िो पूरा िरने िे किए Reuse िर िेता है। 

यानी समान समय पर जब समान Data िे किए बहुत सारे Users Request िरते हैं, तो िेिि पहिी Request िो ही 

Physically Database पर Perform किया जाता है और Database द्वारा Return होने िािे Data िो िोडी देर िे 

किए Cache िर किया जाता है। किर उसी समान Database Request िो जब अन्य Users द्वारा Perform किया 

जाता है, तो अगिी बार आने िािी समान Request िो किर से Database पर Perform नही ां किया जाता, बस्ि 

Cache में Stored Data िो ही Database Request िे Response िे रूप में Return िर कदया जाता है। 

पररर्ामस्वरूप Database पर िम Connections Open िरने पडते हैं और िम Connections से Returned 

Result िो ज्यादा Users िो Serve िर कदया जाता है। कजसिी िजह से High Demand Application िी 

Performance िािी Improve हो जाती है और Database िे Crash होने िी सम्भािना नही ां रहती, क्योांकि 

Database पर समानान्तर रूप से बहुत िम Connections Open किए जाते। 

यहाां ये बात ध्‍यान रखने िािी है कि SqlConnection या OracleConnection Object Instances समान तरीिे से 

Physical Database Connections Open नही ां िरते। बस्ि Database पर Physically Open किए जाने िािे 

Connections िी सां[या िो Connection Pooling Architecture िा प्रयोग िरते हुए Internally ADO.NET द्वारा 

Mange किया जाता है। जबकि Frontend में SqlConnection या OracleConnection नाम िे Specific 
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DbConnection Object िे माध्‍यम से Actual Physical Connection Data िा Access ि Manipulation 

Perform होता है। 

हम ये मान सिते हैं कि एि High Demand Application में बहुत सारे Connections समानान्तर रूप से Open रहते 

हैं और तब ति Open रहते हैं, जब ति कि User िी Requirement पूरी नही ां हो जाती। जबकि ये Opened 

Connection पूरे समय Active यानी उपयोगी नही ां रहते क्योांकि User पूरे समय समान Active Connection िो Use 

नही ां िर रहा होता बस्ि Frontend Application िे अन्य कहस्सोां िे साि भी जरूरत िे अनुसार Interact िर रहा 

होता है। 

इस स्थिकत में िास्ति में User िो उसिे Opened Connection िी पूरे समय जरूरत नही ां होती बस्ि समय िे िुछ 

कहसे्स में ही उसे Opened Connection िी जरूरत होती है। इसकिए समान Opened Connection िे Expensive 

Resources िो Multiple Users िे बीच Pool किया जा सिता है, कजसिे अन्तगणत समान Opened Connection 

िो अिग-अिग Users अिग-अिग समय पर उपयोग में िेते हैं। इस प्रकिया िो Connection Pooling िे नाम से 

जाना जाता है क्योांकि समान Connection िई Users द्वारा जरूरत िे अनुसार Pool (Share) किया जाता है। 

ADO.NET िे साि Connection Pooling िो Use िरना िािी आसान होता है, क्योांकि Connection Pooling 

िरने िे किए हमें एि Developer िे रूप में] यकद हम इसे Use िरना न चाहें] तो इसे Manually Off िरने िे 

अिािा अन्य किसी Default Setting िे साि िुछ भी Extra िरने िी जरूरत नही ां होती है। 

उदाहरर् िे किए SqlClient िे किए यकद हम हमारे Connection िो Pool िरना नही ां चाहते, तो हमें हमारे 

Connection String में कनम्नानुसार एि Key-Value Pair िो Specify िरने िे अिािा और िुछ नही ां िरना होता% 

Pooling=false; 

जैसाकि हमने इसी Chapter में कपछिे Sections में देखा है कि किसी Backend Database िे साि ADO.NET िे 

माध्‍यम से Frontend िा Connection Establish िरने िे किए हमें Connection String Specify िरना होता है, 

कजसमें हमें Database Related Parameters िो Specify िरना होता है। इसकिए जब हम Connection String िा 

प्रयोग िरते हुए किसी Database पर Connection Establish िरते हैं, तो ADO.NET स्वयां ही Internally हमारे 

द्वारा Specified हर Opened Connection िे किए एि Pool Maintain िरता है। 

अन्य शब्ोां में िहें तो ADO.NET Connection String िो एि Key िी तरह प्रयोग िरते हुए Pools िे एि 

Collection िो Maintain िरता है। जब हम किसी Connection Object पर Open() Method िा प्रयोग िरते हुए 

िोई Connection Open िरने िी Request Perform िरते हैं, तो ADO.NET Internally सबसे पहिे ये Check 

िरता है कि क्या उसमें िोई Unused Physical Database Connection Available है या नही ां। 

Physical Database Connection उस स्थिकत में Pooled होने िे किए Ready होता है, जबकि िोई अन्य User या 

Frontend Application िा िोई Part Actively उस Connection िो Use नही ां िर रहा होता है। यानी Effective 

Connection Pooling िे किए जरूरी है कि Connection िो कजतना सम्भि हो उतना देर से Open होना चाकहए, 

जबकि कजतना जल्दी हो, उतना जल्दी Close हो जाना चाकहए। 

यकद Database Server पर समान समय पर बहुत सारे Requests Perform होां] तो ADO.NET स्वयां ही अपने स्तर 

पर Application िे Load िे आधार पर इस बात िा कनर्ण; िेता है कि उसे िब एि से ज्यादा Physical Connection 

िो Concurrently Open िरना है। जबकि Database Server पर Request िी सां[या िम होने पर ADO.NET 

स्वयां ही Opened Physical Connections िो Close भी िरता रहता है। 

इन Connection Pooling Parameters िी एि Default सां[या भी होती है, कजसे हम हमारी जरूरत िे अनुसार 

Connection String द्वारा Configure िर सिते हैं। जबकि Connection String में Extra Parameters िे रूप में 
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हम SqlClient Connection Pooling Key-Value Pairs िो अपनी जरूरत िे अनुसार उस Specific Situation में 

उपयोग में िे सिते हैं। 

 

 

 

 

 

 

Data Provider- 

यह ADO.Net िे connected या relational data access िा part है। यह किकभन्न प्रिार िे data 

sources (Microsoft SQL Server, Oracle, MYSQL और OLEDB) से data access िरने िे किए 

classes प्रोिाइड िरता है। इस समय दो मुख्य data providers SQL Data provider for SQL 

Server और OLEDB data provider for all others एि साि उपिब्ध है। Data source िे data 

provider objects अिग-अिग होते हैं कजसमें कनम्न common class objects use होते हैं- 

1. Connection: यह datasource और program िे बीच communication िे किए connection बनाने 

िे किए use िी जाती है। जैसे- sqlconnection, oledbconnection etc. 

2. Command: इसे SQL Commands िो execute िरने िे किए प्रयोग किया जाता है। यह अिग-

अिग connections िे किए अिग-अिग होता है। जैसे- sqlcommand, oledbcommand। 

3. DataReader: इसिा use data िो access िरने पर get होने िािे data िो store िरने िे किए 

किया जाता है। जैसे- sqldatareader और oledbdatareader 

DataAdapter: यह data source और dataset िे बीच bridge िा िाम िरता है dataset िो fill 

और update िरने िे किए use किया जाता है। 

4. DataSet: यह disconnected data access model पर work िरता है। इसे fill िरने पर सारा data 

इसमें store हो जाता है और data source से इसिा connection समाप्त हो जाता है। और application 

मे work िरते समय इसमे डाटा आिार store होता है। जब पुनः Dataadpter िे द्वारा इसे update 
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किया जाता है तब यह data source मे data िो update िर देता है।यह data tables और data 

relations िे collection िो contain िरता है। इसमें कनम्न classes होती हैं- 

• DataTable: यह data table’s िे collection िो represent िरती हैं। 

• DataView: यह data िे किकभन्न प्रिार िे view िो represent िरती है। 

• DataColumn: यह data table िे column िो represent िरता है। 

• DataRow: यह data table िी row िो represent िरता है। 

• DataRelation: यह किकभन्न प्रिार िी table’s िे relation िो represent िरता है। 

Data Set 

Dataset ADO.Net िे disconnected data access model िा एि कहस्सा है। यह DataTables 

collection और DataRelationCollection िो contain िरता है। यह data िे collection िो 

represent िरता है जो िी Datasource से retrieve किया जाता है। इसे dataadapter िे साि use 

किया जाता है। यह एि ऐसा object है कजसमें data िो एि बार store िरने िे बाद उसे आसानी से 

manipulate किया जा सिता है। इसिे किए datasource और connection िो open रखने िी 

आिश्यिता नही ां पड़ती है। Dataset कबना data source िी जानिारी िे work perform िरता है 

जहाां यह सभी जानिारी dataadapter िे पास होती हैं। dataset requrest किए गई data िी एि 

copy अपने पास store िर िेता है जो िी बाद में datasource मे जािर update हो जाती हैं। यह एि 

साि िई tables और उनिे relations िो contain िरता है। 

DataAdapter 

यह ADO.Net data provider िा एि main part है। यह Dateset और DataSoruce िे बीच 

communication िे किए use किया जाता है। DataAdapter िो dataset िे साि use किया जाता है। 

यह दोनोां objects कमििर data access और data manipulation provide िारता है। 

DataAdapter किकभन्न SQL statements जैसे- Select, Insert, update और delete operation िो 

Datasource मे जािर perform िरता है। इसमें Insert, update और delete perform िरने पर 

Data Dateset से जािर datasource मे changes िो store होता है। जबकि Select operation िा 

use Dataset िो Fill िरने िे किए किया जाता है। DataAdapter dataset िे किए operations 

perform िरता है। 

Connection 

यह ADO.Net data provider िा important part है कजसिा use DataSource और application 

िे बीच communication बनाने िे किए किया जाता है। यह communication path connection 

string पर depend िरता है। connection object, specify किए गए database से connection 

बनािर उसे open िरता है। एि बार connection िे सही तरह से create होने िे बाद SQL 
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commands िो execute िर desired operations perform किए जा सिते हैं। सभी tasks िे 

perform होने िे बाद इस connection िो close भी किया जा सिता है। Connection िो open और 

close िरने िे किए connection object िमश open() और close() methods provide िरता है। 

साि ही यह connection string िो define िरने िे किए ConnectionString property provide 

िरता है। 

 

 

Command- 

यह ADO.Net िा एि important component है कजसिा use SQL Statements िो execute 

िरने िे किए किया जाता है। यह connection object मे define किए गए data source से SQL 

statements िो execute िर data िो manipulate िरता है। यह सभी प्रिार िी SQL 

statements िो execute िरता है। command object connection object िा use िर इन 

statements िो execute िरता है। इसे use िरने िे किए सबसे पहिे connection object िो 

define िर उसे open िरते हैं। इसिे बाद अिग-अिग sql statements िो execute किया जाता 

है। command object िुछ properties और methods contain िरती है। 

Properties of Command object 

Connection:यह connection िो define िरने िे किए use िी जाती है। 

CommandText:यह SQL command िो define िरने िे किए use िी जाती है। 

CommandType:यह command type याकन text या stored procedure िो define िरने िे किए 

use िी जाती है। 

Methods of Command object 

ExecuteReader: यह Select command िे execute होने पर retrieve होने िािे डाटा िो store 

िरने िे किए use िी जाती है। 

ExecuteNonQuery: यह अन्य sqlcommands जैसे – insert, update और delete िे किए use 

िी जाती है। 
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ExecuteScaler: यह single result जैसे – count etc. िे किए use िी जाती है। 

Microsoft SQL Server (SQLDB) 

यह Microsoft द्वारा develop किया गया एि Dababase server software है जो िी RDBMS िो 

support िरता है। यह SQL language िा use िर data accessing provide िरता है। Microsoft 

िी सभी programming language इसे support िर database िे किए use िर सिती हैं। यह 

ADO.Net िा एि महत्वपूर्ण कहस्सा है। ADO.Net data provider इसिे किए अिग से सभी data 

accessing facilities provide िरती है। इसे use िरने िे किए सबसे पहिे SQLClient 

,namespace िो import िरते हैं कजसिे किए imports System.Data.SqlClient statement िा 

use किया जाता है। इसमें कनम्न classes होती हैं। SQLDB िे किए SQLConnection object िा use 

किया जाता है। 

 

 

Display Data on data bound controls- 

 

To Display Data on Data Bound Controls 

(डाटा बाउण्‍ड Controls िे माध्‍यम से Data िो प्रदकशणत िरना) 

VB.NET में हम Data Bound Controls िे माध्‍यम से Database से Data िो प्राप्‍त िर सिते हैं तिा 

Form पर इन Controls में Data िो प्रदकशणत िर सिते हैं। यहााँ पर Text Box (Data Bound 

Controls) िे माध्‍यम से Data िा प्रदकशणत िरने िे किये कनम्‍नकिस्खत Steps िो Follow िरते हैं – 

Step 1 : VB.NET में New Project Create िरते हैं तिा एि नया Form Design िरते हैं। oledb 

Data Adaptor िी सहायता से Database से Connectivity िरते हैं तिा Dataset बनाते हैं। 

Step 2 : Tool Box से तीन Text Boxes तिा एि बटन िो िामण पर कडजाइन िरते हैं। 

Step 3 : Text Box िो कसिेक्‍ट िरिे टैक्‍थ‍ट बॉक्‍स िी Properties Window में Data Bindings 

तिा Dataset िी प्रॉपटी िो सेट िरते हैं। यही Step शेष Text Boxes िे किये िरते हैं। 
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Step 4 : Form िे अांतगणत कनम्‍नकिस्खत Coding िरते हैं – 

Dim dm As Binding Manager Base 

Private Sub Form Load (By Val sender As System. Object, By Val a As System. 

EventArgs) Handles My Base.Load 

dm = Me. Binding context (Dataset 11, “Pubs”) 

Oledb Data Adaptor 1. File (Dataset 11) 

bm.position = 1 

End Sub 

 

 

Step 5 : Button पर डबि स्िि िरते हैं तिा Code Window में कनम्‍नकिस्खत Coding िरते हैं- 

Me.Binding Context (Dataset 11, “Pubs”).Position 

=(Me.Binding Context (Dataset 11, “Pubs” ).Position + 1) 

End Sub 

Step 6 : Form िो Run िरते हैं। 

 

How to Display data on data grid- 

डाटा किड में डाटा िो प्रदकशणत किस प्रिार किया जाता है 

डाटाग्रिड में डाटा को प्राप्‍त करना (Data Receiving in Data Grid) : यहााँ पर हम प्रोिामर िी 

सहायता िे किए एि ऐसा उदाहरर् बना रहे हैं, जहााँ पर डाटा िो प्राप्‍त किया जा सिे। इसिे किए 

कनम्‍नकिस्खत थ‍टैप्‍स िो Follow िरते हैं – 

• एि नया किण्‍डोज एस्ििेशन प्रोजेक्‍ट शुरू िरते हैं तिा उसिा नाम “Exam” से सुरकक्षत िरते हैं। 

• टूिबॉक्‍स से OleDb Data Adapter िन्‍‍टर ोि िो डर ैग िरिे िॉमण पर डर ॉप िरते हैं, तब डाटा एडैप्‍टर िा 

किजाडण शुरू हो जाता हैं। 

• किजाडण िे समाप्‍त हो जाने पर टर े में िन्‍‍टर ोि आ जाते हैं। 

• डाटा िो प्राप्‍त िरने िे किए डाटासैट िी आिश्‍यिता होती हैं। 

• डाटासैट बन जाने पर, टूिबॉक्‍स से डाटाकिड (Data Grid) िन्‍‍टर ोि िो टूिबॉक्‍स से िॉमण पर बनाते हैं। 
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• इस िन्‍‍टर ोि िी डाटासोसण (Data Source) प्रॉपटी िो कसिैक्‍ट िरते हैं, तब उसिे अन्‍‍तगणत किथ‍ट आती 

हैं। 

• इस किथ‍ट से Data Set 11. Groups कििल्‍प िो कसिैक्‍ट िरते हैं। 

• डाटा िो एडैप्‍टर से प्राप्‍त िरने िे किए िॉमण िे िोड इिैन्‍‍ट में कनम्‍न प्रिार से िोकडांग िरते हैं- 

 

Private Sub Form1 Load (By Val Sender As System. Object, By Val e As System. 

Event Args) 

Handles My Base. Load 

OleDb Data Adapter1.Fill (Data Set11) 

End Sub 

• िापस िॉमण पर आने पर Data Grid कदखाई देता हैं। 

• प्रोजेक्‍ट िो रन िराने पर उसिा आउटपुट हमें प्राप्‍त हो जाता हैं। 

• इस उदाहरर् में डेटाबेस िो Data Grid िे अन्‍‍दर प्राप्‍त किया हैं। इसी प्रिार प्रोिामर अपनी 

आिश्‍यितानुसार किकभन्‍‍न िन्‍‍टर ोि िे अन्‍‍दर भी डाटा िो प्राप्‍त िर सिता हैं। 

•  

जैसे – DataGrid, ComboBox, ListBox, TextBox, आकद। 

 

 

Create Crystal Reports using Visual 

Studio 
 

Create Crystal Report Using Visual Studio 

Create a Visual Studio Project 
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Creating a Project in Visual Studio 

1. Open Visual Studio and create a new project. 

2. Choose C#. 

If you want to choose VB.NET you can go ahead and choose 

VB.NET. Designing reports with Crystal Reports is independent of the 

language or type of application. The steps are the same for both VB.NET 

& C#. For this Example, I will choose C# 

3. Choose Windows Desktop Application. 

4. Under Various Application, Template chose Windows Forms Application 

5. Enter Name of the Project as MyFirstReport. Click OK.  Visual C# 

Project is opened for you. 

6. Rename the form as frmCrystalReport 

Create a Crystal Report 

https://www.tektutorialshub.com/wp-content/uploads/2015/07/Create-your-first-Crystal-Report-using-Visual-Studio-Create-a-Project.jpg
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Now let us create a crystal Report. The following steps will guide you to add 

the new report 

1. Under Solution Explorer select your Project. 

2. Right Click and Add New Item. This displays the list of available 

templates. 

 

3. Select Reporting Template Group. 
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4. Scroll down to select the Crystal Report template. 

5. Enter the name as  EmployeeList.    

6. Click on Add to Create your first Report. This will take you to Crystal 

Report Gallery. 

Crystal Report Gallery 

You can Create Report using the following options 

 

Report Wizard 

• Using a Report Wizard.   

Selecting this option will open the crystal report wizard which takes you 

through the various steps to help you in creating the report. 

• As a blank Report.      

This will open a blank report. 

• From an Existing Report.    

Here you are asked to select an existing report and the new report use. 

Report Expert. 

Crystal Report for Visual Studio comes with three report Experts. 
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• Standard Format. 

This expert will create the standard report. 

• Cross Tab.  

This expert will create a specialized report known as cross tab report. 

• Mail Label.  

This expert will create mailing label report where data is displayed in a 

format that is suitable for use as address labels on envelopes. 

In this example let us select Report Wizard and Standard Expert and then click 

on next. You will be taken to the Standard Report Creation wizard. 

Standard Report Creation wizard 

 

First dialogue box under this allows you to choose the data source that would 

be used in the report.  It has three options 
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1. Project Data.   

This Option lists the data source connections already available in your 

project. 

2. My Connections.    

This Option lists the most recently used data source connection so that 

you can quickly add it your report. 

3. Create New Connection. 

This Option allows us to create a new connection to data source. 

Let us Select OLE/DB option to connect to our data source.  click on the plus 

sign right next to OLE/DB option. This will open the OLE/DB Dialog Box. 

OLE/DB Dialog Box. 

 

This Dialog Box Option displays the list of available OLE/DB Providers. Choose 

the appropriate OLE/DB Provider to connect to your data source. 

Let us chose SQL Server Native Client 11.0 which is used to connect to the 

SQL Server Database. Click on next.  
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OLE/DB Connection Info Dialog Box. 

OLE DB Connection 

Information 

You will then see OLE/DB Connection Info Dialog Box. Here you need to 

input the database credential to connect to the data source. 

Input server Name. You can either input the user id and password or choose 

Integrated security option. If you choose User id and password, then the 

crystal report will ask you for user id & Password while displaying the report.  I 

will choose Integrated security. 

Select the database from the drop-down. select northwind database. Click on 

next when you are done. 

https://www.tektutorialshub.com/wp-content/uploads/2015/07/Create-Your-First-Crystal-Report-OLE-DB-Connection-Information2.jpg
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OLE/DB Advance Information Dialog Box 

OLE DB Advance Information 

dialogue box 

You will then see OLE/DB Advance Information Dialog Box. Make 

appropriate changes if any and click on Finish to go back to Standard Report 

Creation wizard. 

Standard Report Creation wizard 
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Northwind data connection we just made is displayed under OLE/DB option 

under Create the new connection.  

Click on plus sign to expand to the database.  Any Tables, Stored Procedures, 

Views under the selected data source connection is automatically displayed 

under the connection and is available to the report. Select the appropriate the 

table/Stored Procedures/View which you want in your report. 
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Employee Table is Selected 

1. Select employees table. 

2. Click right arrow key to add the table to the report. 

The table will appear in the selected tables box on the right side. You can add 

more than one table to report. Click on next. You will be taken to Fields 

Dialog box. 

Fields Dialog Box. 
On the left  side, you can see the list of fields from the employee table. These 

fields are now available to the report.   You can select any field just by double-

clicking on them. Selected fields will appear on fields to display box on the 

right side. 
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Select any field on the left side box and click on browse data and view the 

database values of the selected field. 

Fields Dialog box 

You can hold the control key and select multiple fields at once. 

1. Select FirstName, LastName, Title, Address, City. 

2. You can then click on right arrow key to add the fields to the report. 

3. The fields will appear on the right side box. 

4. You can move the field up and down by dragging the fields or using up 

or down arrow buttons. 

5. Place the fields in the order you want them to appear in the Report. 

6. Click on finish. You will then see the crystal report designer and the 

report is generated for you. 
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Created Report 

Crystal Report Viewer Control. 
The next step is to show the crystal report in our windows form. To do this, 

you need to add Crystal Report Viewer control to the form. 

 CrystalReportViewer Control is a usercontrol class and can be used as any 

other user control class. Primary Function of is to Display Reports. 
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Crystal Report Viewer Control 

1. Open the form frmcrystalreport which we have created. 

2. Locate Reporting tab in the toolbox. 

CrystalReportViewer control is listed under the Reporting Tab in the 

toolbox. So go to the toolbox and locate the reporting tab. 

3. Select the crystalReportViewer drag and drop it unto the form. 

Good, now we have added the control. 

Bind Report to Crystal Report Viewer 

Control 



Visual Basic/VB.Net 

 PAARAS INSTITUTE OF EDUCATION (KASHYAP SIR) 

 

Code in 

form load event 

1. Open frmCrystalReport.   

1. Go to the code-behind class. 

2. Under the form load event write the following code (Double click form 

header to create the event). Declare a variable rpt to hold the instance 

of the employeeListemployeeList is the name of the report which we 

have created. 

Assign this to the report source property of the crystal report viewer 

control. The code will look like this. 

 

1 

2 

3 

4 

  

private void frmCrystalReport_Load(object sender, EventArgs e) 

{ 

    EmployeeList rpt = new EmployeeList(); 
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5 

6 

7 

    crystalReportViewer1.ReportSource = rpt; 

} 

  

Run Your First Report 

Report Generated 

1. Save the Project. 

2. Run the project. 

Congratulations you have created your first crystal report 
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Generate a Report using Crystal Reports in Visual 

Studio  

 

I was searching the internet for Crystal reports in 2010 and I found in 2005, but was not 

able to find any particular tutorials for 2010. So I thought, let me take a chance to write 

it for some beginners like me who have not worked on Crystal Reports earlier. 

In this article, I will show you simple report creation process with screenshots. A picture 

is worth more than a thousand words, so I always believe in an article with screenshots. 

Let's start by creating a new website in VS2010. See the following screen: 
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Figure 1 

As per figure 1, create a new website in VS2010 and name it as per your choice. Now let 

me show you the database table structure. 

 

Figure 2 
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The above figure shows the db table structure. And the below figure (Figure 3) will 

show you some sample data in the table: 

 

Figure 3 

If you want to run this sample project directly, then you can download the database 

script from the link at the top. 

Now we have to create an xsd file as a blank data source as we are going to use strong 

data type. Here I will divide this tutorial in 5 sub sections as mentioned below: 

• Simple report using Crystal Reporting Tool 

• Group report 

• Chart report 

• Sub report 

• Cross tab report 

Simple Report using Crystal Report 

The below figure shows you the process to create an XSD file. 
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For adding an XSD file, click on Solution Explorer -> Right Click on Project -> click on 

Add new Item and then it will show you the below screen. 

 

Figure 4 

Click on the ok button, so it will ask for confirmation to put that file in App_Code folder. 

Just click ok and that file will open in the screen as a blank screen. 

Now we will add one blank datatable to that XSDfile. Just right click on the file and 

select Add -> Datatable. It will add one DataTable1 to the screen. Figure 5 shows how 

to add datatable to XSD file. 
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Figure 5 

Now datatable1 is added to XSD file. Now we will add data column to 

the datatable1 as per figure 6. Remember whatever fields (columns) we add here, it 

will be available to show on the report. So add column which you want to display in 

your reports one by one here. 
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Figure 6 

Remember to give the exact same name for data column as in database and also select 

data type which is the same as database, otherwise you will get an error for field and 

data type mismatch. 

Once we add all the required columns in datatable, then set property for 

the datacolumn as it has in database. The below figure will show you how to set 

property for data columns. Default datatype for all the columns is string here so 

if datatype is other than string then only change it manually. 

Just right click on the datacolumn in datatable and select property and from property 

window, select appropriate datatype from DataType Dropdown for that datacolumn. 
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Figure 7 

That's it. XSD file creation has been done. Now we will move to create Crystal report 

design. 

Just click on the Solution Explorer -> Right click on the project name and select crystal 

reports. Name it as per your choice and hit the add button. 

Figure 8 will show you the creation process of Crystal reports. 
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Figure 8 

Click on the add button and one .rpt file will be added to the solution. And also, it will 

ask for the report creation type of how you want to create the report. Figure 9 will show 

you a screenshot. 
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Figure 9 

Just click ok button to proceed. It will lead you to figure 10: 
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Figure 10 

Under project data, expand ADO.NET Datasets and select DataTable1 and add to the 

selected table portion located at the right side of the windows using > button. 

Now click on the Finish button and it will show the next screen (Figure 11): 
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Figure 11 

Once report file is added, you can see Field Explorer on the left side near server 

explorer. 

Expand Database Fields, under that you will be able to find Datatable that we have 

created earlier. Just expand it and drag one by one filed from Field Explorer to the rpt 

file under detail section. 

Now the report design part is over. Now we have to fetch the data from database and 

bind it to dataset and then bind that dataset to the report viewer. 

Let's go step by step. 

First Drag a CrystalReportViewer control on aspx page from tool box as per below 

screen: 
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Figure 12 

Now we will fetch the data, pass data to the dataset and then add that dataset to the 

Crystal Report. Below is the C# code which will do the job: 

C# 

using CrystalDecisions.CrystalReports.Engine; 

using CrystalDecisions.Shared; 

using System.Data; 

using System.Data.SqlClient; 

using System.Configuration; 

Below is the final code for reports: 

C# 

Shrink ▲    

protected void Page_Load(object sender, EventArgs e) 

{ 

    ReportDocument rptDoc = new ReportDocument(); 

    dsSample ds = new dsSample(); // .xsd file name 

    DataTable dt = new DataTable(); 
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    // Just set the name of data table 

    dt.TableName = "Crystal Report Example"; 

    dt = getAllOrders(); //This function is located below this function 

    ds.Tables[0].Merge(dt); 

 

    // Your .rpt file path will be below 

    rptDoc.Load(Server.MapPath("../Reports/SimpleReports.rpt")); 

 

    //set dataset to the report viewer. 

    rptDoc.SetDataSource(ds); 

    CrystalReportViewer1.ReportSource = rptDoc; 

} 

 

public DataTable getAllOrders() 

{ 

    //Connection string replace 'databaseservername' with your db server name 

    string     sqlCon = "User ID=sa;PWD=sa; server=databaseservername;INITIAL 

CATALOG=SampleDB;" + 

                        "PERSISTSECURITY INFO=FALSE;Connect Timeout=0"; 

    SqlConnection Con = new SqlConnection(sqlCon); 

    SqlCommand    cmd = new SqlCommand(); 

    DataSet ds = null; 

    SqlDataAdapter adapter; 

    try 

    { 

        Con.Open(); 

        //Stored procedure calling. It is already in sample db. 

        cmd.CommandText = "getAllOrders"; 

        cmd.CommandType = CommandType.StoredProcedure; 

        cmd.Connection = Con; 

        ds = new DataSet(); 

        adapter = new SqlDataAdapter(cmd); 

        adapter.Fill(ds, "Users"); 

    } 

    catch (Exception ex) 

    { 

        throw new Exception(ex.Message); 

    } 

    finally 

    { 

        cmd.Dispose(); 

        if (Con.State != ConnectionState.Closed) 

            Con.Close(); 

    } 

    return ds.Tables[0]; 
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} 

Now just save everything and run report. It will look like the below figure: 

 

Figure 13 

Grouping in Crystal Report 

Here we will see only report design and rest of the things, you can refer from Section 1. 

Here we will group Customer, Product, Order and Quantity. For details, just go 

through Figure 14. 

Just add a report (.rpt) file to the solution. Select the appropriate dataset from popup 

window. Once it's done, then select grouping option like figure 14. 
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Figure 14 

Now, right click on the report, select Report -> Group Experts and the resulting 

window will look like figure 15: 
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Figure 15 

Now we want to group like Customer Name and Product name so first 

add Customer to the right Panel. Then move product name to the right panel like figure 

16: 
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Figure 16 

This time Crystal report design will be different than the previous time. See figure 17. 

GroupHeaderSection1 and GroupHeaderSection2 are added to the report designer. 

Here Group #1 Name refers to Customer Name and Group #2 Name refers to Product 

Name. 

And also GroupFooterSection1 and GroupFooterSection2 are added below if you 

want to add something to group footer. 
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Figure 17 

Now under every group, we want to show the number of orders per customer and 

productwise, so for that, we have to add summary to the GroupFooterSection2. Refer 

to Figure 18. 
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Figure 18 

Right Click on the GroupFooterSection select Insert -> Summary. It will show you the 

next screen (Figure 19). And I have also added Order_ID and Product_Qty field to the 

detail (section 3) part. 
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Figure 19 

In summary window, select the column which you want to summarize in the first 

dropdown. 

Select Sum (First option) from the calculate drop down. 

Summary Location is already set to the report footer. So just click ok to place that 

summary field to the report. 

By default, Summary field is added to the Report Footer section so move it to 

the groupFooterSection2 if you want to group product wise, move it to 

the GroupFooterSection1 if you want to group Customer wise or keep it at original 

place if you want to sum all ordered products. I have moved to the FooterSection1 so 

it will show Customer Wise Total Quantity. Refer to Figure 20. 



Visual Basic/VB.Net 

 PAARAS INSTITUTE OF EDUCATION (KASHYAP SIR) 

 

 

Figure 20 

Now save the report and run it finally. It looks like figure 21. 



Visual Basic/VB.Net 

 PAARAS INSTITUTE OF EDUCATION (KASHYAP SIR) 

 

 

Figure 21 

Chart in Crystal Report 

Chart is the most important and visible part of the reporting tool. Crystal has very 

powerful feature to add chart in report. Let's see how to add chart in CR. Here also, we 

will see only designing of the chart for other thing. Please refer to Section 1. 

Here we will show customer wise product ordered quantity in chart. X portion will 

display Customer name and Y portion will display customers total ordered quantity. 

First add charts to the report design. 

Right click on the .rpt file and select Insert->Chart. Refer to figure 22. 
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Figure 22 

Once you add chart to the report, it will not show chart on the report file but with 

mouse pointer you can see one blank rectangle is moving. So just click on the Report 

header. It will open popup for chart style and other options. Refer to figure 23. 
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Figure 23 

Now from type tab, select type of the charts like bar chart, line chart, pie chart, etc. form 

the left side. Select sub type from the right pane like side by side chart, percentage 

bar chart, etc. I am not going into the detail of it. I am leaving it for you to practice 

work. 

And also select vertical or horizontal radio button from the below section if you want to 

change the chart style vertically or horizontally. Check Use depth effect check box if 

you need shadow effect on the graph. Refer to figure 23. 
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Figure 24 

As per figure 24, move to the next tab data. There are three boxes, available fields, on 

change of and show values. So move Customer Name from available fields to on 

changes of box, and move Product Quantity filed to the show value box and click ok. 

Now you can see chart is added to the report header section as per figure 25. 



Visual Basic/VB.Net 

 PAARAS INSTITUTE OF EDUCATION (KASHYAP SIR) 

 

 

Figure 25 

Now, just save the report and run it. You can see a Report as a chart on the screen. 

Report Inside Report (Sub Report) 

Crystal reports provide reports inside report feature which are normally known as a 

subreport feature. 

Let me explain it in detail. Here also, we will design only sub report design. For rest of 

the things, refer to Section 1. 

Add new report to the solution. Then add Report->Group and select 

only Customer name because we want to design report for each customer and sub 

report product wise. So there will be only one group header inside 

the Customergroup header as per figure 26. 
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Figure 26 

Now right click on Detail section and select Insert->Subreport. Refer to figure 27. 
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Figure 27 

Once we add subreport, it will show screen like figure 28. 
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Figure 28 

As per figure 28, by default, choose a Crystal Report in project is selected if you want 

to add report from the project, then otherwise select create a subreport with the 

report wizard. Once we select create a subreport with Report Wizard (3rd radio button), 

we have to click on the Report Wizard button to select report type and data source just 

do as Part - 1 first. Then click on ok button so like chart report it will show a moving 

rectangle around mouse, click on the detail section where you want to show subreport. 

Now to edit the sub report, refer to figure 29. 
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Figure 29 

Click on the edit subreport option and format the report as per your need. Here I will 

suggest add product name and product quantity or you can add chart also for sub 

report. When you click on the subreport button, it will open subreport designer, actually 

CR will create a separate .rpt file but it will remain hidden inside the main .rpt file so we 

can't see it.. 

Now run the report and you can see the result, report inside report like figure 30. 
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Figure 30 

Here number 1 is the main report and number 2 is the subreport it's showing title as 

Product wise. 

Cross Tab Report in Crystal Report 

First, let me make it clear as to what is a Cross tab report. Normally, we generate report 

row wise like first we show customer name, then product wise, etc. But suppose we want 

to see report as column wise like product name should be displayed as column in 

report, then cross tab report comes into the picture. See result of Cross Tab report in 

figure 31. 
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Figure 31 

Here also, I will show how to design cross tab report only, for rest of the things, refer 

to Section 1. 

First add .rpt file to the solution. Then add cross report to the Report Header section as 

per the below figure (Refer to figure 32). 

Remember we can add cross tab report only in Report header or report footer section. 



Visual Basic/VB.Net 

 PAARAS INSTITUTE OF EDUCATION (KASHYAP SIR) 

 

 

Figure 32 

Once we click on cross tab report options, it will show moving rectangle around mouse 

pointer just place it to the report header section. 

As we click on header section, it will lead to the figure 33. 
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Figure 33 

As per the figure, move Customer name field to the Rows section, Product name we 

want to show as a Column so move it to the Columns fields, and we want to 

show product total so move it to the summarized fields. That's it. Just run the report 

and you can see the output as shown in figure 31. 

It's as simple as that. If you have any queries regarding any type of the above 

mentioned reports, please let me know by way of comments. I will try my level best to 

fulfill your request. 

 

 


